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1 Installing the program 

1.1 Requirements 
The program can be installed on a PC that meets the following minimum re-
quirements: 

• IBM compatible computer, 133 MHz 
• Windows 95/98/ME, Windows NT/2000/XP 
• 64MB RAM 
• 5 MB of free hard drive space 
• Monitor 640X480 pixel resolution 
• Keyboard, mouse 

 
Recommended requirements: 

• IBM compatible, 300 MHz 
• Windows NT/2000/XP 

 
The following additional equipment is required to operate the program in the 
online mode: 

• A free PCI or PCMCIA slot or a USB connector1 
• A CAN interface card from Ixxat (PCI or PCMCIA or USB) or from Na-

tional Instruments (PCI or PCMCIA) 
• A 24V AC / 2A power pack 
• Device connection cable with counter plug for the 6+PE-pole or 11+PE-

pole external plug 
• CAN cable with counter plug for the 5-pole CAN external plug and 9-

pole D-Sub plug (female).  
 

1.2 Installing the CAN Interface Card 
A CAN interface card and the associated driver are not included with deliv-
ery of the program. A CAN interface card is required in case the program 
should be used in online mode.  
 

 
The program supports CAN interface cards from the vendors Ix-
xat and National Instruments. When installing the CAN interface 
card, please observe the notes in the operating manual that is 
included with the CAN interface card.  

 
In case of problems during installation of the CAN interface card, the associ-
ated driver software, or the configuration of the computer in general, please 
contact the reseller  of the CAN interface card or computer.  
The CAN interface card in the PC must work flawlessly in order to use the 
program in online mode. To make sure that this card is working properly, the 

                                                      
1 The usage of a CAN interface-card with USB interface requires Windows 
2000/XP or higher. 

Requirements

CAN Interface card
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test and diagnosis software that is included with the CAN interface card 
should be used to check for proper functionality beforehand of the operation 
of the program in online mode.  

1.3 Installing the program 
Start the setup program and follow the instructions. It is strongly recom-
mended to remove older program versions before performing a new installa-
tion. To remove a program, go to the Windows "Control Panel", click on 
"Software" and then start the respective "Uninstall" program.  
 

 
An installed CAN interface card from National Instrumentsmust 
be initially configured before the program can be used in online 
mode. The port that is being used (port 1 or port 2) must be set 
to the interface name "CAN0" or "CAN1" in the CAN driver set-
tings. Observe all of the notes contained in the operating manual 
included with the CAN interface card.  
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2 Safety instructions 
 
The following safety guidelines must be observed when operating one or 
several devices with the Moog Valve Configurator: 

2.1 Initial start-up 
 

 
Operating in the non-pressurized condition is strongly recommended 
while becoming familiar with the program and the device functions 
and also during the initial start-up procedure! 

 
Activation of the device through the program is permissible only 
when doing so cannot result in a dangerous condition in the ma-
chine and its surroundings.  

 

2.2 Operation through the CAN bus 
It is not permissible to operate the program on a CAN bus on which there is 
already data traffic.  
The device and the program must communicate via a direct (point-to-point) 
connection.  
To establish a direct connection between the CAN interface card and a de-
vice, remove the bus cable from the device and connect the device directly 
to the CAN interface card on the PC.  
If a safe operation of the device by the program cannot be ensured , the de-
vice must first be put into a non-pressurized condition.  
Before operation of the program in a CAN network, the following points must 
be noticed: 
 

 

 
The exchange of data with the device can be disturbed if another 
CAN bus participant (e.g. a controller) attempts to access the 
device at the same time.  

 
Node-guarding may be activated only when no other CAN bus 
node is monitoring the device via this service.  

 
CAN message frames can also be received from other CAN bus 
nodes. This may trigger unforeseeable events! 

 
The program may not, for reasons of safety, be used within a 
machine facility for visualization purposes or as an operating 
terminal.  

Important notes
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3 Using the program 
The program can be used to control, to configure and to parameterize hy-
draulic servo valves and radial piston pumps that have integrated CANopen 
interfaces.  
 

 
The program is intended exclusively for commissioning Moog 
hydraulic servo valves and radial piston pumps with integrated 
CANopen interfaces.  

 
The program can be used to transfer configuration and parameter data from 
the computer to the device or to transfer the device's current settings to the 
computer where they can be displayed or saved.  
The computer can be connected via the installed CAN interface card to a 
CAN bus with up to 127 nodes. However, the program can communicate 
with only one device in the bus system at a time. The device to which a con-
nection shall be established is selected by means of the node ID, which ex-
plicitly identifies a CANopen device on the bus.  
Using the program, the following tasks can be performed: 

• Become familiar with the device functions 
• Bring a servo valve or a radial piston pump into operation 
• Perform a diagnosis 
• Operate and control a servo valve or radial piston pump 
• Save the device's configuration and parameter data on a PC 
• Transfer configuration data from a PC to the device 
• Configure a device's CANopen node ID 
• Configure a device's CAN bit rate 

 

Using the program 
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4 Communication between program and 
device 

4.1 CAN bus and CANopen 
The device and the program will communicate over the CAN bus using stan-
dardized protocols according to the CANopen communication standard.  
The CAN bus is a differential two-wire bus developed for fast and fault-free 
networking. Its versatile capabilities and high reliability make it equally suit-
able for applications within machine facilities. For these reasons, the CAN 
bus has become a widely used standard.  
CANopen is a standardized communications profile that makes it easy to 
connect CANopen devices from a variety of manufacturers to a single CAN 
bus.  
The communications profile complies with the standard DS 301, version 4.0 
and can be obtained from the CiA.  
The node ID and the bit rate are set over the CAN bus by means of the 
Layer Setting Services (LSS) in accordance with the CiA standard DSP 305, 
version 1.0.  

4.2 Device profile 
Device profiles are defined in order to facilitate the connection of various 
classes of devices, such as hydraulic and electric drives, PLCs, and angle 
transmitters.  
The functionality of a Moog servo valve or a radial piston pump equipped 
with a CANopen interface corresponds with the device profile "Fluid Power 
Technology" in compliance with the CiA standard DSP 408.  

4.3 Data exchange 
A machine controller or other bus nodes can exchange data with the device 
in real time over the CAN bus. This data includes especially set points and 
actual values as well as control and condition messages. In addition to this 
real-time transmission, the PLC and the device can also exchange configu-
ration data, parameters, and diagnosis data at any time.  
The PLC or other bus nodes transfer set points, device commands, and con-
figuration data/parameters over the CAN bus to the device.  
The PLC or other bus nodes can read from the device actual values, condi-
tion information, diagnosis data, and the current configuration/parameters.  
 

CAN bus and 
CANopen interface  

Communications pro-
file 

CiA standard DSP 408 
device profile 
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5 Program functions 

5.1 Modes 
The program can be operated in two different modes: offline and online. The 
current mode can be determined by the appearance of the program's win-
dow title. In addition, the ticker text will be activated in the lower right in the 
status bar when in the online mode. The default mode at program start is the 
offline mode.  
The program can be brought into the online mode only when one of the pro-
gram-supported CAN interface cards is installed on your PC.  

5.1.1 Offline Mode 
In the offline mode, there is no exchange of data with the device.  
When parameters are changed, only the values of a locally existing memory 
map of a virtual device will be modified. Then these values can be saved in a 
file, for example.  
This mode provides access to information about the program itself and about 
the existing device parameters, thereby enabling the user - within a limited 
scope - to learn something about the device's functionality.  
When the CAN interface card is not installed, the program can be operated 
only in the offline mode.  
 

5.1.2 Online Mode 
The program can be operated in the online mode after the CAN interface 
card has been installed and successfully initialized . This makes the PC an 
active bus node.  
Operating the program in the online mode requires an operationally-ready 
servo valve/radial piston pump that is connected to the PC's CAN interface 
card by means of properly-installed cabling. Another requirement of data ex-
change between the program and a device is proper configuration of the bit 
rate and the node ID (see chapter 6.5).  
In online mode, the program will receive all messages that are present on 
the CAN bus. The program then filters out from all of the sent messages only 
those messages necessary for the communication between the program and 
the device addressed over the node ID.  
As soon as the program establishes a connection with a device, the program 
itself will also send messages via the CAN bus.  
 

 

If it is not possible to communicate with the device even when 
the CAN interface card is installed, there may be problems with 
the cabling or the wrong bit rate may be set. In this case, neither 
sending nor receiving of messages will be possible (communica-
tion error).  
Another possible problem is that a device is set to a node ID that 
is different from the program setting. In this case, an attempt to 
establish communication will be acknowledged by a time-out (no 
bus node replies).  

 
 

Offline and online 
modes 

CAN interface card not 
installed 

CAN interface card ini-
tialized 



 

5 Program functions User levels

7 Manual MoVaCo, version 0.2; 04/03 © Moog GmbH

5.2 User levels 
The device has a number of functions and parameters that can be used only 
by authorized personnel. These parameters are protected by a password. 
The program employs user levels to display only those parameters that are 
accessible with proper authorization.  

 
The following instructions describe the functions that are avail-
able in the standard user level. Higher user levels are not in-
cluded in these instructions.  

 

5.2.1 Standard user levels 
The standard user level is the default level when the program is started. In-
cluded in this level are all functions for operating the device within the ma-
chine facility.  
 

5.2.2 Other user levels 
Additional functions are available in other user levels. They are used for 
calibration, diagnosis, control optimization of the servo valve / radial piston 
pump, and for test procedures. These user levels are reserved exclusively 
for properly authorized persons. A password is required to activate these 
levels.  
 

User levels 

Standard user levels

Other user levels
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5.3 Main and additional windows 
The main window provides the user interfaces for configuring the bus and 
devices.  
Depending on the view that is open and the current user level, other win-
dows, tool- and menu bars will be available for certain tasks in addition to 
the main window. Additional windows can be opened by selecting the re-
spective menu entries or clicking on the icons in the toolbar. Refer to the re-
spective chapters for descriptions of these windows.  

5.4 Configuration views 
The program's main window has two fundamentally different views, depend-
ing on which task the user wants to perform.  
The default view after program start is the bus configuration view.  
After a connection has been established to a device or after loading a stan-
dard template in the offline mode, the device configuration view will open.  
The device configuration view can be left at any time so that the bus configu-
ration view will be loaded again. 

5.4.1 Bus configuration view 
This view permits setting of the communication parameters that are neces-
sary for the communication between the program and the device.  
The program functions are accessible through the menu entries and the 
toolbar within the program window.  
 

Views 

Bus configuration view 
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Fig. 1: Bus configuration view 

5.4.1.1 Messages 
At the lower margin of the program window are boxes that display messages 
with a variety of meanings: 
The event display shows bus activities that are related to the exchange of 
data between the device and the program.  
The warnings display shows bus activities that require the user's attention. 
These activities may include, among others, cancellation of data transmis-
sion (communication abort or communication time out), as well as global bus 
messages (like the boot-up message).  
The error display shows error messages sent by the device as well as data 
transmission errors (protocol errors).  
 

5.4.1.2 Bus configuration menu 

 

Fig. 2: Menu in the bus configuration view 

Event display

Warnings display

Error display
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In the bus configuration view, the following commands are available through 
the menu: 
 
Menu entry Description 

File→Exit Exits the program 

Network→Offline Switches to the offline mode (deactivation of 
the CAN interface card) 

Network→Online Switches to the online mode (activation of the 
CAN interface card) 

Network→Layer Setting Ser-
vices→Node ID Configuration 

Starts the assistant for modifying the device's 
CAN node ID 

Network→Layer Setting Ser-
vices→Bitrate Configuration 

Starts the assistant for modifying the device's 
CAN bit rate 

Help→About Opens the program information window 

 

5.4.1.3 Bus configuration toolbar 
The toolbar provides direct access to functions contained in the menus.  
To see a brief description of a function, place the mouse pointer over the 
icons in the toolbar.  
 

 

Fig. 3: Toolbar in the bus configuration view 

Icon Description 

 Switches to the offline mode (deactivation of 
the CAN interface card) 

 Switches to the online mode (activation of the 
CAN interface card) 

 Opens the program information window 

 
 

5.4.2 Device configuration view 
This view permits setting or viewing of the device parameters.  
The program functions are accessible through the menu entries and the 
toolbar shown in the program window. The device's parameters are repre-
sented by data fields and selection and display elements on the tabs.  
 

Toolbar 

Device configuration 
view 
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Fig. 4: Device configuration view 

Messages with a variety of meanings are displayed in the message displays 
at the lower margin of the program window, see chapter 5.4.1.1.  

5.4.2.1 Device configuration menu 

 

Fig. 5: Menu of the device configuration view 

The following commands are available in the menu of the device configura-
tion view: 
Menu entry Description 

File→Open→Data (*. log) Opens a dialog for loading a file, which con-
tains the device's parameter data.  
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File→Save ...  Opens a dialog for saving the device's parame-
ter data  

File→Close Closes the device configuration view and re-
turns to the bus configuration view  

File→Exit Exits the program 

Network→Offline Switches to the offline mode (deactivation of 
the CAN interface card) 

Network→Online Switches to the online mode (activation of the 
CAN interface card) 

Network→Layer Setting Ser-
vices→Node ID Configuration 

Starts the assistant for modifying the device's 
CAN node ID 

Network→Layer Setting Ser-
vices→Bitrate Configuration 

Starts the assistant for modifying the device's 
CAN bit rate 

Trace→Oscilloscope ...  Opens the oscilloscope window 

Data→Upload All Loads all of the device's data into the program 
via the CAN bus 

Data→Access Level ...  Opens a dialog for entering a password. This 
must be done in order to switch to a higher 
user level 

Format→Hexadecimal Converts the data fields to the hexadecimal 
format. Data fields without number representa-
tion or those that are in the percent format are 
excepted from the conversion 

Format→Decimal Converts the data fields to the percent format. 
Data fields without number representation or 
those that are in the percent format are ex-
cepted from the conversion 

Format→Percent Converts the data fields to the percent format. 
Only those data fields that permit depiction of 
percentages will be affected 

Window→Engineering Interface Opens the engineering interface window 

Window→Data Logger Opens the data logger window 

Help→About Opens the program information window 

 

5.4.2.2 Toolbar in the device configuration view 
The program's most important functions can be reached by clicking on the 
icons in the toolbar. To see a brief description of a function, place the mouse 
pointer over the icons in the toolbar.  

CAN Interface Offline

CAN Interface Online

Engineering Interface

Hexadezimal

Dezimal Prozent

Datei speichern

Datei laden

Hilfe

 

Fig. 6: Toolbar of the device configuration view 

Toolbar 
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Icon Description 

 Opens a dialog for loading a file, which con-
tains the device's parameter data. 

 Opens a dialog for saving the device's parame-
ter data  

 Switches to the offline mode (deactivation of 
the CAN interface card) 

 Switches to the online mode (activation of the 
CAN interface card) 

 Converts the data fields to the hexadecimal 
format. Data fields without number representa-
tion or those that are in the percent format are 
excepted from the conversion 

 Converts the data fields to the percent format. 
Data fields without number representation or 
those that are in the percent format are ex-
cepted from the conversion 

 Converts the data fields to the percent format. 
Only those data fields that permit depiction of 
percentages will be affected 

 Opens the engineering interface window 

 Opens the data logger window 

 Opens the program information window 

5.5 Operating elements 

5.5.1 Tabs 
In the device configuration view, data fields are arranged on individual tabs. 
Each tab contains one or several device functions. The tabs are arranged 
hierarchically according to function. A list of functional groups can be found 
in Table 1 on page 26.  

5.5.2 Data fields 
The data fields are accessible within the windows or tabs. Individual parame-
ters with numbers or text as contents are shown in data fields or can be ed-
ited there. A brief description next to or above the data field or a group of 
data fields provides information about the parameters shown there. For the 
exact name of a parameter, move your mouse over the data field and a text 
balloon will appear.  
 
Data fields can be read-only or readable and writable.  
 

Tabs 

Data fields 

Access rights
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Fig. 7: Read-only and readable/writable data fields 

Read-only data fields have a colored text or icon background. Users cannot 
modify these fields by making entries. The fields are updated when the re-
spective data is loaded from a device.  
 
Readable and writable data fields have a white text or icon background.  Us-
ers can make entries in these fields, thereby changing the data represented 
by the field. The fields are updated when the associated data is loaded from 
the device or a file.  
 
To edit a data field, just click on it to place the cursor in the field or keep hit-
ting the Tab key on the keyboard until the desired field is selected and then 
enter the new value through the keyboard. When you hit the Return key, the 
value will be overtaken; if in the online mode, the data will additionally be 
transferred to the device. If you do not hit the Return key after making an en-
try but instead just move to another field (by clicking on the field or by using 
the Tab key), the value you entered will still be overtaken and transferred to 
the device.  
You can also use the "up arrow" and "down arrow" keys to raise or lower the 
value one step at a time.  
 

 
When in online mode, the updated values in a parameter control will 
be transferred immediately to the device. Even incorrectly entered 
values are applied immediately. Therefore, failure to observe the 
safety regulations could result in dangers to persons and/or dam-
ages to the machines.  

 
Text fields can display the ASCII characters 'a' - 'z', 'A' - 'Z', '0' - '9' and all 
other special printable characters. In the case of writable text parameters, 
these characters can be entered into the text field.  

Read-only data fields 

Readable and writable 
data fields 

Editing data fields 

Text fields 
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Numerical data fields can be shown in decimal, hexadecimal, or percentage 
format. The percentage format is available only for those data fields that 
have a reference to a 100% condition (such as a spool position).  
 
Example: A decimal value of 16384 for the spool position set point corre-
sponds to a spool position set point of 100%.  
 

 

Fig. 8: Numerical data fields and their number formats 

You can centrally set a format for all data fields by choosing the Format 
menu entry or by clicking on the toolbar. You can switch between the for-
mats at any time. When you convert to a format, all data fields will be con-
verted to the new format.  
The label in front of the data field tells you which number format is repre-
sented: 

d stands for decimal format 
x stand for hexadecimal format 
No icon in front of a number field means percent format.  

 
Parameters with selection options can be shown by means of a selection list 
or a slider.  
The selection list pops up when you click on the arrow or hit the space key. 
To select and transfer the value, click on the desired value in the pop up list, 
use the up/down arrow keys to highlight the value, or enter the name that is 
displayed and then hit the Return key. 
The list entries or the slide bar positions can also be selected directly with 
the up/down arrow keys. A selection list need not to be popped up to ac-
complish this.  
To adjust the slide bar, use the mouse to drag the button to the desired 
value or simply click on desired position directly on the slide bar path.  
 

 

Fig. 9: list control 

The stored value will be written to the parameter when you click on a button 
control or press the Return or space key on a selected button control.  
 

Numerical data fields 

Selection lists and 
slider 

Button controls
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Buttons for controlling and visualizing state machines are simultaneously 
linked with the readable/writable control parameter and the read-only status 
parameter. In this case, the current status is indicated by color-coding of the 
button while the activated control command is indicated by bold print.  
 

 

Fig. 10: Color-coding of a status 

 

Fig. 11: Bold print of a control command 

Function Graphs  are used to visualize a function, which could depend on 
several parameters. The function's input values are shown on the X-axis; the 
output values are shown on the Y-axis.  
 

 

Fig. 12: Function Graph  

5.5.3 Display of data consistency 
In the online mode, data consistency is depicted by the color of the parame-
ter of a data field.  
If the value of a device parameter has been updated since the connection 
was established (read or written at least once), then the text or the number 
will be shown in black on a white or gray background.  
 

 
Some device data may have changed since the most recent 
data calibration without the program detecting this. This data in-
cludes especially the device control values and status informa-
tion. Data that the device itself has modified is not automatically 
transferred to the program! 

 
 

state machine controls 

Function Graphs  

up-to-date values 
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If the value of a device parameter has not been updated since the connec-
tion was established, the text/number will be shown in gray. This may hap-
pen if, for example, the data transfer between device and the program was 
canceled.  
When parameters are shown in gray, this indicates that the parameter val-
ues may differ between the device and the program and that a data transfer 
is required.  
If an error occurs  during data transfer or if the transfer of data from the de-
vice is canceled due to invalid data or other reasons, then the text/number of 
the affected parameter will be shown in red.  
 

5.5.4 Pop-up menu 
Right-clicking on one of the data fields will open a pop-up menu to display in-
formation about the data linked to the field as well as possible reading and 
writing actions.  
 

 
Fig. 13: Pop-up menu 

Select the /attributes/ menu entry to open a window that provides detailed in-
formation about the linked parameter(s) (see Fig. 9).  

 

Fig. 14: Parameter attributes window 

 
The menu entry /upload/ can be selected only in online mode and permits 
loading of data for the linked parameter(s) from the device into the program.  
 
The menu entry /download/ can be selected only in the online mode; in addi-
tion, the linked parameter(s) must be writable.  

Not updated values

Data transfer error or 
cancellation 

Pop-up menu

Attributes 

Upload 

Download 
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This function enables writing (from the program to the device) of the data 
linked to this data field. This option has the same effect as manually writing a 
value into a data field, except the set value must not be re-entered.  
 
The menu entry /upload continuous/ can be selected only in online mode 
and permits continuous loading of data for the linked parameter(s) from the 
device into the program.  
 
 

Upload continuous 
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6 Working with the program 

6.1 Starting the program 
The first time the program starts, a dialog will appear by which the initializa-
tion of a CAN interface card installed in the PC can be started. If no CAN in-
terface card is installed, cancel the initialization. If the program was started 
without initialization or if an initialization has failed, then it will be possible to 
use the program in offline mode only.  
Once the program successfully initializes the CAN interface card, at next 
program start the card will be initialized automatically without requesting the 
program again.  
The CAN interface card can be initialized at any time by choosing the appro-
priate menu entry.  

Select the menu entry /Network→Board Configuration/ and select the de-
sired CAN interface card.  
 

 
If no CAN card is installed or if the installation of the driver for 
the CAN interface card has errors, an error message will appear. 

 

6.2 Changing between Offline and Online mode 
Changing from one mode to the other can be done at any time.  
To do this, select the menu entry /Network→Offline/ or /Network→Online/ or 
click on Stop (to go offline) or Go (to go online) in the toolbar.  
 

6.3 Bus configuration 
Immediately after the program starts, the bus configuration view opens (refer 
to chapter 5.4.1). The parameters necessary for communication between the 
program and the device can be configured here.  
 

6.3.1 Configuring the CAN interface card 
If the initialization of the CAN interface card was successful, the driver that is 
used and its version will be shown in the pictogram with the figure of the 
CAN interface cards. If the CAN interface card was not initialized, this field 
will be empty or a message will be shown there.  
 
The CAN interface cards can have one or several separated ports. The inter-
face number can therefore be changed if the CAN cable is attached to an in-
terface other than the specified interface.  
 
 

Automatically initializ-
ing the CAN interface 
card 

Manually initializing the 
CAN interface card 

Changing mode

CAN interface driver 
and version 

CAN port 
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The bit rate that is applied for the CAN interface card can be set here. The 
selected bit rate must comply with the one configured in the device. Other-
wise, communication will not be possible. The factory setting for Moog servo 
valves / radial piston pumps with a CANopen interface is 500Kbit/sec.  
 

 
Setting the bit rate in the bus configuration view will not initiate a 
change in the device (there is still no communication); only the 
connection parameters of the CAN interface card will change.  

 

6.3.2 Selecting CAN bus nodes 
Within the pictogram with the figure of a Moog servo valve, a data field that 
permits setting of the CAN node ID is located. Enter here the node ID of the 
bus node with which you want to establish a connection. The factory setting 
for Moog servo valves / radial piston pumps with a CANopen interface is 
node ID 127.  
 

 
Setting the node ID in the bus configuration view will not initiate 
a change in the device (there is still no communication); this only 
sets the connection parameters.  

6.3.3 Connecting to the device 
The button /Connect/ is used to start a connection to the bus node ad-
dressed by the node ID.  Note, that in offline mode, a standard template 
saved in the PC will be loaded without any CAN communication taking 
place.  
If the bus node addressed over the node ID is not a supported device or if 
there is no node with the selected node ID attached to the bus, the connec-
tion will be canceled.  
Because of the following reasons, a successful connection to the device will 
be avoided.  

- The CAN interface card was not yet installed or initialized. See chap-
ter 1 (Installing the program) and chapter 6.1 (Starting the program).  

- The CAN bus cabling was not done correctly. See chapter 9.2 (CAN 
bus cabling).  

- An incorrect bit rate or node ID was selected. See chapter 6.3 (Bus 
configuration) and chapter 6.5 (Setting the CAN node ID and bit 
rate).  

Bit rate 

Node ID 

Connecting to the de-
vice 
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6.4 Device configuration 

6.4.1 Setting the device's parameters 
Each tab provides access to a certain group of functions. By a click on a tab 
it will pop up to the foreground. The following table shows an overview of the 
available tabs and device functions: 

Tab controls
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Tab Description 

Device control Device control (see chapter 8.1) 

 Spool position Spool position (see chapter 8.1.4) 

 Pressure Pressure (see chapter 8.1.2) 

Communication Communication (see chapter 8.2) 

 CANopen CANopen 

  Network Management Network management (see chapter 0) 

  Receive PDO's Receive PDO (see chapter 8.2.2) 

  Transmit PDO's Send PDO (see chapter 8.2.3) 

Application Application (see chapter 8.3) 

 Spool position Spool position 

  Limit Limit (see chapter 8.3.1.1) 

  Scale Scaling (see chapter 8.3.1.2) 

  Ramp Ramp (see chapter 8.3.1.3) 

  Direction Directional dependent gain (see chapter 
8.3.1.4) 

  Characteristic Characteristic compensation (see chapter 
8.3.1.5) 

  Deadband Deadband compensation (see chapter 
8.3.1.6) 

  Zero Zero point correction (see chapter 8.3.1.7) 

 Pressure Pressure 

  Limit Limit (see chapter 8.3.1.1) 

  Scale Scaling (see chapter 8.3.1.2) 

  Ramp Ramp (see chapter 8.3.1.3) 

  Characteristic Characteristic compensation (see chapter 
8.3.1.5) 

Controller Controller (see chapter 8.4) 

 Spool position Spool position (see chapter 8.4.2) 

  Monitoring Control monitoring (see chapter 8.4.1) 

 Pressure Pressure (see chapter 8.4.3) 

  Transducer Pressure transducer (see chapter 8.4.3.1) 

  Parameters Control parameter (see chapter 8.4.3.2) 

  Monitoring Control monitoring (see chapter 8.4.1) 

Diagnosis Diagnose (see chapter 8.5) 

Store / Restore Save / load (see chapter 8.6) 

Information Information (see chapter 8.7) 

  Table 1: Device functions and tabs 
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6.4.2 Reading the value of a parameter from the device 
After connection has been established with the device and the device con-
figuration view has been loaded, the current device data will be loaded 
automatically over the CAN bus into the program.  
Individual parameters can be updated manually over the pop-up menu entry 
/Upload/.  To open the pop-up menu, right-click on the data field. See chap-
ter 5.5.4.  
A data object can be read continuously over the menu entry /upload con-
tinuous/ in the pop-up menu. This permits tracking of the continually chang-
ing values (such as the actual values). See chapter 5.5.4.  

All device data can be updated over the menu entry /Data→Upload All/. See 
chapter 5.4.2.1.  
A failed reading operation will be indicated by a message in the warnings 
display at the lower margin of the program window. The affected data field(s) 
change their color to red.  
 

 
Data objects can be read only when the program is in the online 
mode.  

 

6.4.3 Writing the value of a parameter to a device 
Only data with the respective write access can be written.  
When a data field is edited, the value will be transferred immediately to the 
device.  
To transfer a set value to the device once again, just click on the pop-up 
menu entry /download/. Open the pop-up menu by right-clicking on the data 
field.  
A failed writing operation will be indicated by a message in the warnings dis-
play at the lower margin of the program window. The affected data field(s) 
change their color to red.  
 

 
Data objects can be written into the device only when the pro-
gram is in online mode.  

6.5 Setting the CAN node ID and bit rate 

6.5.1 Setting the node ID 
A unique node ID must be assigned to each CANopen bus node.  
To assign a new node ID to a device, proceed as follows: 

Open the menu /Network→Layer Setting Services (LSS) → Node ID Con-
figuration/. A window with a settings assistant will open. Follow the assis-
tant's instructions.  

Upload 

Upload continuous

Data→→→→Upload All 

Read errors

Editing data fields

Download 

Read errors
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6.5.1.1 Node ID configuration, step 1 

 

Fig. 15: Node ID settings assistant 

Select the method with which the device should be switched into the node ID 
configuration mode.  
If the device is connected directly with the CAN interface card (a point-to-
point connection), then the device can be switched directly into the configu-
ration mode. To do this, select the upper radio button and click on "Forward".  
If the device is not connected directly with the CAN interface card (in other 
words: the device must be configured via a bus with several attached de-
vices), then the device can only be switched into the configuration mode by 
entering a unique LSS address. To do this, select the lower radio button and 
click on "Forward".  

6.5.1.2 Node ID configuration, step 2 
If a direct connection was selected, the entry form below will appear. In this 
form, click on "Forward", to put the device in the configuration mode.  

Direct connection, pro-
gram - device 

Connection to a device 
on the bus 
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Fig. 16: Switching the device into the configuration mode directly 

If a connection to a device on the bus was selected, the form shown below 
will appear.  
Enter the data into the fields. To do this, the product key, the revision num-
ber, and the serial number of the device is required. This information can be 
found either on the device's type plate or in the included documentation.  

 

Fig. 17: Switching the device into the configuration mode by using the 
unique LSS address 

Click on "Forward", so that the LSS address will be transferred to the device. 
If the transferred LSS address is not correct, an error message will appear.  
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6.5.1.3 Node ID configuration, step 3 
 
Enter into this entry form the node ID to which the device should be config-
ured to.  

 

Fig. 18: Assigning a node ID 

Click on "Forward", so that the selected node ID will be transferred to the 
device.  

6.5.1.4 Node ID configuration, step 4 
To permanently store the device's previously set node ID, select the "Store" 
check box.  

 

Fig. 19: Saving the node ID 

Assigning a node ID 

Saving a node ID 
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Click on "Forward" to execute or skip the save procedure, respectively.  

6.5.1.5 Node ID configuration, step 5 
In this entry form, click on "Forward" to leave the device's configuration 
mode.  

 

Fig. 20: Leaving the configuration mode 

6.5.1.6 Node ID configuration, step 6 
In this entry form, click on the button "Finish" in order to leave the configura-
tion assistant.  

 

Fig. 21: Exiting the node ID configuration assistant 

Leaving the configura-
tion mode 

Leaving the configura-
tion assistant 
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6.5.2 Setting the bit rate 
Every CAN bus node must be set to the same bit rate.  
If a device is set to another bit rate, proceed as follows: 

Open the menu /Network→Layer Setting Services→Bitrate Configuration/. A 
window with the settings assistant will open. Follow the assistant's instruc-
tions.  

6.5.2.1 Configuration of the bit rate, step 1 

 

Fig. 22: Bit rate settings assistant 

Select the method with which the device should be switched into the bit rate 
configuration mode.  
If all bus nodes will be set to a new bit rate or if the device is connected di-
rectly with the CAN interface card (a point-to-point connection), then the at-
tached bus node can be switched directly into the configuration mode. To do 
this, select the upper radio button and click on "Forward".  
If the device is not connected directly with the CAN interface card (in other 
words: the device must be configured via a bus with several attached de-
vices), then the device can only be switched into the configuration mode by 
entering a unique LSS address. To do this, select the lower radio button and 
click on "Forward".  

6.5.2.2 Configuration of the bit rate, step 2 
If a direct connection was selected, the entry form below will appear. In this 
form, click on "Forward", to put the device in the configuration mode.  

Direct connection, pro-
gram - device 

Connection to a device 
on the bus 
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Fig. 23: Switching the device into the configuration mode directly.  

If connection to a device on the bus was selected, the form shown below will 
appear.  
Enter the data into the fields. To do this, the product key, the revision num-
ber, and the serial number is required. This information can be found either 
on the device's type plate or in the included documentation.  

 

Fig. 24: Switching the device into the configuration mode through the unique 
LSS address 

Click on "Forward", so that the LSS address will be transferred to the device. 
If the transferred LSS address is not correct, an error message will appear.  
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6.5.2.3 Configuration of the bit rate, step 3 
In the "Baudrate" field, select the CAN bit rate to which the device should be 
configured to.  
 

 

Fig. 25: Assigning bit rate 

Click on "Forward", so that the selected bit rate will be transferred to the de-
vice.  

6.5.2.4 Configuration of the bit rate, step 4 
 

To permanently store the device's previously set bit rate, select the "Store" 
check box.  
 

 

Fig. 26: Saving bit rate 

Assigning a bit rate 

Saving the bit rate 
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Click on "Forward" to execute or skip the save procedure, respectively.  

6.5.2.5 Configuration of the bit rate, step 5 
In this form, select the 'Activate Bit Timing Parameter' check box if the bit 
rate should be activated immediately after elapsing of the wait time specified 
in the field "Pe-

riod".  

Fig. 27: Activate bit rate 

Click on "Forward" to execute or skip the change-over procedure, respec-
tively.  

6.5.2.6 Configuration of the bit rate, step 6 
In this entry form, click on "Forward" to leave the device's configuration 
mode.  

 

Fig. 28: Leaving the configuration mode.  

Activating bit rate

Leaving the configura-
tion mode 



 

Activating the node guarding function 6 Working with the program

32 Manual MoVaCo, version 0.2; 04/03 © Moog GmbH

6.5.2.7 Configuration of the bit rate, step 7 
In this entry form, click on the button "Finish" in order to leave the configura-
tion assistant.  

 

Fig. 29: Leaving the configuration assistant 

6.6 Activating the node guarding function 
The CANopen node-guarding protocol can be activated in order to monitor 
the device. Activation of this function is useful when the data in an applica-
tion will be transferred to the device only at long intervals and it should be 
certain that the connection between the device and the program exists dur-
ing the entire time period. Call up the menu entry /Network→Node Guarding 
Settings. .. /. In the "Node Guarding Configuration" window, click on the box 
"Enable" and select there the desired time interval. Acknowledge the new 
settings with "OK".  

Leaving the configura-
tion assistant 

Device monitoring 
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Fig. 30: Node-guarding configuration dialog 
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7 Engineering interface 
The Engineering Interface can be used to display the current values of a pa-
rameter or enter new values. This gives experienced users the ability to en-
ter parameters through the keyboard or to read parameters without requiring 
them to switch to the respective tabs and data fields.  
The data fields dependent on the respective parameters will be automatically 
updated during every read or write operation through the engineering inter-
face. 
Opening the engineering interface 
To open the engineering interface, click on the respective icon in the toolbar 
or choose the  /Window→Engineering Interface/ entry in the menu (see 
chapter 5.4.2).  
 

 

Fig. 31: Engineering interface 

7.1 Internal parameter name 
Every parameter managed by the program is identified by an internal name. 
The internal name of a parameter can be obtained by means of the attribute 
window, which can be opened via the pop-up menu entry /attributes (right 
click into the control).  
Scalar parameters are addressed directly over the internal name without the 
addition of a suffix.  

Engineering interface 

Internal parameter 
name 

Scalar parameters 
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Example: splset addresses the spool position set point <Spool Position Set 
Point>.  
An array is addressed as a complete object (consisting of several array ele-
ments) by employing the internal name without the specification of a suffix.  
Example: splchrtbl addresses the entire spool position characteristic table 
<Spool Position Characteristic Table>.  
array elements 
An individual element in an array is addressed by means of the array name 
followed by a suffix.  
The suffix is comprised of the sequence: 

- Opening bracket ( [ ) 
- Element number 
- Closing bracket ( ] ) 

 
Example: splchrtbl[0] addresses the first element of the table.  
 
String parameters are addressed directly by means of the internal name 
without the specification of a suffix.  

7.2 Number formats 
Numerical values can always be entered in decimal and hexadecimal format. 
Exceptions are the data objects of the "float" type, in which the values can 
only be entered in floating point format. Hexadecimal values have the prefix 
"0x", floating point values have a decimal point.  
When data objects can be displayed as a percentage, the value will be 
shown as a floating point value. The value 1.0 corresponds to a value of 
100%. The relationship between values shown as percentages is defined in 
the Reference Manual that describes the device's functions.  
Example: a decimal value of 16384 for the spool position set point <Spool 
Position Setpoint> corresponds to a value of 100%, the floating point value is 
1.0.  

7.3 Reading parameter values  
At the engineering interface prompt, enter the internal name of the parame-
ter that should be read and confirm with the Return key.  
If the program is in the online mode, the identified parameter will first be read 
from the device over the CAN bus. In the offline mode, the value will be read 
from the memory's image of a virtual device. The value then appears in-
dented in a new line.  
In the case of arrays, the internal parameter name (with suffix) will appear in 
front of the value of the individual element.  
Syntax: > InternalName [Suffix] 
 

Array parameter

Strings 

Decimal and hexadeci-
mal display 

Percentage depiction
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7.4 Writing parameter values 
At the engineering interface prompt, enter the internal name of the parame-
ter that should be written. Then enter a space followed by the numerical 
value or text that should be written and confirm with the Return key.  
Numerical values can be entered as decimals or hexadecimals with the ex-
ception of data objects of the "float" type, in which case the value must be 
entered as a floating point value. Hexadecimal values must be preceded 
with "0x".  
Percentage values must be entered with a decimal point.  
 
Syntax: > InternalName [Suffix]  ‚_‚ value 
 

 
Arrays cannot be written in their entirety.  
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8 Description of the parameters 
The following chapter gives a brief overview of the most commonly used pa-
rameters that are found in all devices. For complete descriptions of the pa-
rameters and functions, refer to the Reference Manual that describes the 
device's functions.  

8.1 Controlling the device 
The following functions and parameters apply to all types of control (for in-
formation on control modes, see chapter Fehler! Verweisquelle konnte 
nicht gefunden werden.).  

 

Fig. 32: Device control tab 

8.1.1 Spool position 
In the control modes "spool position closed loop" or "spool position open 
loop" as well as the "p/Q closed loop", the following parameters are effective: 

 

Fig. 33: Spool position tab 
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8.1.1.1 ValvePositionControl_Setpoint 
The spool position set point is the set point that is transferred via the bus for 
the control modes "spool position control closed loop" or "spool position con-
trol open loop" , respectively. This setpoint will only take effect in case the 
device is in the device state ACTIVE.  
The device mode <DeviceMode> must be set to {Setpoint Input via Bus} in 
order to make this parameter effective.  
Specification: see CiA DS408 

 
The device mode, the control mode, and the device state influ-
ence whether this parameter will affect the control.  

8.1.1.2 ValvePositionControl_DemandValueGenerator_HoldSetPoint 
The spool position hold setpoint is the setpoint that is transferred via the bus 
for the control modes "spool position control closed loop" or "spool position 
control open loop" , respectively. This setpoint will only take effect in case 
the device is in the device state HOLD.  
Specification: see CiA DS408 

 
The control mode and the device state influence whether this pa-
rameter will affect the control.  

8.1.1.3 ValvePositionControl_DemandValueGenerator_DemandValue 
The spool position demand value is the value calculated by the demand 
value generator and is provided to the spool position controller.  
Specification: see CiA DS408 

8.1.1.4 ValvePositionControl_ActualValue 
The spool position actual value is the actual position value returned from the 
spool position transducer to the controller.  
Specification: see CiA DS408 

8.1.1.5 ValvePositionControl_ControlDeviation 
The control deviation of the spool position controller is the difference be-
tween the spool position demand value and the spool position actual value.  
Specification: see CiA DS408 

8.1.2 Pressure 
In the control modes "pressure control closed loop" or "pressure open loop" 
as well as the "p/Q closed loop", the following parameters are effective: 

 

Fig. 34: Pressure tab 

<Setpoint> 

<HoldSetPoint> 

<DemandValue> 

<ActualValue> 

<SpoolPositionControl 
Deviation> 
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8.1.2.1 ValvePressureControl_Setpoint 
The pressure set point is the set point that is transferred via the bus for the 
control modes "pressure control closed loop" or "pressure control open loop"  
as well as for "p/Q control closed loop" respectively. This setpoint will only 
take effect in case the device is in the device state ACTIVE. 
The device mode <DeviceMode> must be set to {Setpoint Input via Bus} so 
that this parameter will be effective.  
 

 
The device mode, the control mode, and the device status influ-
ence whether this parameter will affect the control.  

 
Specification: see CiA DS408 

8.1.2.2 ValvePressureControl_DemandValueGenerator_HoldSetPoint 
The pressure hold setpoint is the setpoint that is transferred via the bus for 
the control modes "pressure control closed loop" or "spool position control 
open loop" as well as for "p/Q control closed loop" , respectively. This set-
point will only take effect in case the device is in the device state HOLD. 
 

 
The control mode and the device state influence whether this pa-
rameter will affect the control.  

 
Specification: see CiA DS408 

8.1.2.3 ValvePressureControl_DemandValueGenerator_Demand 
The pressure demand value is the value calculated by the demand value 
generator and is provided to the pressure controller.  
Specification: see CiA DS408 

8.1.2.4 ValvePressureControl_ActualValue 
The actual pressure value is the actual pressure value (of the medium in the 
connection port A of the servo valve) feed from the integrated pressure 
transducer to the controller. The maximum pressure specified on the type 
plate corresponds to 100%.  
Specification: see CiA DS408 

8.1.2.5 ValvePressureControl_ControlDeviation 
The pressure controller's control deviation is the difference between the 
pressure demand value and the actual pressure value.  
Specification: see CiA DS408 

8.1.3 Device modes 

8.1.3.1 Device_DeviceMode 
With the parameter <DeviceMode> the input which will be used for the set 
point can be set. It can be chosen between the modes {Setpoint Input via 
Bus} and {Setpoint Input locally}.  

<Setpoint> 

<HoldSetPoint>

<Demand> 

<ActualValue>

<ControlDeviation>

<DeviceMode>
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Specification: see CiA DS408 

Set point input via bus 
In this mode, the set points <SpoolPositionSetpoint> and <PressureSet-
point> that are transferred over the CAN bus will take effect as set points.  

Set point input local 
In this mode, a signal source configured on the device will take effect to pro-
vide the set points. Depending on the versions and variations, these can be 
analog inputs or other sources.  

8.1.4 Control modes 

8.1.4.1 Device_ControlMode 
The parameter <ControlMode> allows to select between following control 
modes: spool position control, pressure control, or p/Q control (depending on 
variant).  
 

 
Since all devices, depending on model and variant, are set by 
default and optimized to a particular type of control, it is not al-
ways possible to freely choose the control mode. The available 
control modes can be retrieved via the <Capability> parameter; 
see chapter 8.7.1.9.  

 
Specification: see CiA DS408 

Spool position control (volume flow control) 
In this control mode, the position of the spool positionspool position will be 
controlled. The specified set point corresponds to a certain spool position. 
The spool position is proportional to the demand signal. 
 A constant volume flow will be established depending on the pressure drop 
∆p on the individual control edges and the control edge opening, which re-
sults from the spool position.  

Pressure closed loop 
In this control mode, the pressure will be controlled in connection port A. The 
specified set point corresponds to a certain pressure in the connection port.  

Pressure and volume flow control (p/Q function) 
This control mode is a combination of the pressure and volume-flow func-
tions.  

Spool position open loop / pressure open loop 
With the option {Open Loop} in the "spool position" or "pressure control 
closed loop" control mode, the control loops are opened; in this case, the 
spool position will be moved only under control. These modes are suitable 
only for test operation.  

{Setpoint Inputvia Bus} 

{Setpoint Input locally} 

<ControlMode> 

{Spool Position Closed 
Loop} 

{Pressure Closed 
Loop} 

{p/Q} 

{Open Loop} 
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8.1.5 Device status 
The device status is controlled by one of the control words <De-
vice_Controlword> or <Device_LocalControlWord> and displayed by means 
of the status word <Device_StatusWord>.  

8.1.5.1 Device_ControlWord 
The control word will be written as soon as one of the buttons {INIT}, {DIS-
ABLED}, {HOLD}, {ACTIVE} or one of the blue arrows {Reset Fault} or one 
of the check boxes {Ramp Stop} or {Enable Pressure} is clicked on.  
 

 

Fig. 35: Bus tab 

 
After the device is switched on, the control word is always set to 
INIT, the ramp function is not stopped, and the pressure control-
ler is not enabled (relevant only for the p/Q control mode).  

 
Specification: see CiA DS408 

INIT 
Switches the device to the initialization status. The device function is deacti-
vated.  

DISABLED 
Switches the device to the deactivation status. The driver stage for the motor 
is deactivated.  

HOLD 
Switches the device to the hold status. The device controls to achieve the 
hold set point (depending on control mode, to achieve the set point <Valve-
PositionControl_DemandValueGenerator_HoldSetPoint> or <ValvePres-
sureControl_DemandValueGenerator_HoldSetPoint>).  

ACTIVE 
Switches the device to the active status. The device controls to achieve the 
specified set point (depending on the control mode, to the set point Valve-
PositionControl_DemandValueGenerator_SetPoint> or <ValvePressureCon-
trol_DemandValueGenerator_SetPoint>, or in the device mode <De-
vice_DeviceMode> set point over the bus {Setpoint Input locally} to achieve 
a locally specified set point, such as over an analog input).  

Device status

<Controlword>

{INIT} 

{DISABLED}

{HOLD} 

{ACTIVE} 
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Reset Fault 
Switches the device from a fault status back to the status of DISABLED or 
HOLD 

Ramp Stop 
Actuating this switch stops the ramp function of the demand value generator. 
The device status remains unchanged. See chapter 8.3.1.3.  

Enable Pressure 
Actuating this switch enables the pressure controller to enter the p/Q control 
mode. The device status remains unchanged.  

 
The device status will change by changing the control word pa-
rameter <Device_Controlword> only if the parameter <Local> is 
not set to {Controlword local}.  

 
The device will adopt the states of HOLD and ACTIVE only 
when an electrical "enable" signal is pending at the device plug.  

 

8.1.5.2 Device_LocalControlWord 
The local control word will be written as soon as one of the buttons {INIT}, 
{DISABLED}, {HOLD}, {ACTIVE} or one of the blue arrows {Reset Fault} or 
one of the check boxes {Ramp Stop} or {Enable Pressure} is clicked on.  
The local control word is a manufacturer-defined parameter and is differenti-
ated from the standardized control word only with regards to the switch-on 
value and the bus address (index / sub-index).  
After the device is switched on, the local control word is always set to {AC-
TIVE}, the ramp function is not stopped, and the pressure controller is not 
enabled (relevant only for the p/Q control mode).  
For a function description, see chapter 8.1.5.1.  
 

 

Fig. 36: Local tab. 

 
The device status will change by changing the local control word 
parameter <Device_LocalControlWord> only if the parameter 
<Device_Local> is not set to {Controlword via Bus}.  

{Reset Fault} 

{Ramp Stop} 

{Enable Pressure} 

<LocalControlword> 
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The device will reach the states of HOLD and ACTIVE only 
when an electrical release signal is pending at the device plug. 

 
Specification: manufacturer-defined 

8.1.5.3 Device_Local 
With the local switch, one of the two controlwords can be selected, by which 
the device state machine shall be controlled. Click in the corresponding 
check box in order to set one of the options {Controlword via Bus} or {Con-
trolword Local}. See Fig. 35 and Fig. 36.  
Specification: see CiA DS408 

Controlword via Bus 
The device status is controlled by the standardized control word <De-
vice_Controlword>.  

Controlword Local 
The device status is controlled by the manufacturer-defined local control 
word <Device_LocalControlWord>.  

8.1.5.4 Device_StatusWord 
The status word indicates the device's status by marking one of the fields 
{INIT, DISABLED, HOLD, or ACTIVE} with a color. Other bit states within the 
status word are indicated over the signal fields {Limit}, {Ramp}, {Error} and 
{Ramp Stop} and {Enable Pressure}.  
Specification: see CiA DS408 

Limit 
This field will be activated when the set-point generator's limit function indi-
cates that the adjusted limit has been exceeded. See chapter 8.3.1.1.  

Ramp 
This field will be activated when the set-point generator's ramping function 
has not yet reached the end value. See chapter 8.3.1.3.  

Error 
This field will be activated when the control monitor signalizes a controller 
fault. See chapter 8.4.1.  

Ramp Stop 
This field will be activated when the set-point generator's ramp function has 
been stopped and the ramp has not yet reached the end value.  

Enable Pressure 
This field will be activated when the pressure controller is activated in the 
p/Q control mode.  

<Local> 

{Controlword via Bus}

{Controlword Local}

<Statusword>

{Limit} 

{Ramp} 

{Error} 

{Ramp Stop}

{Enable Pressure}
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8.2 Communication 
All settings that affect the device's CANopen communication parameters can 
be set in the Communication →  CANopen tab control. 
 

 
Fig. 37: Network management tab 

8.2.1 Network management 
Unless otherwise specified, all parameters and functions that appear in the 
tab Communication → CANopen → Network Management are defined in 
CANopen Standard and are known under the names listed below.  

8.2.1.1 Device Identification 

NodeID 
Device addresses that are unique on the entire CAN bus 
Specification: CiA DS301 

DeviceType 
The device type:The number 408 designates the device profile DS408 (Fluid 
Power Technology).  
Specification: CiA DS301 

IdentityObject 
Worldwide unique device identification via the following parameters: 
<IdentityObject_VendorID> - manufacturer number, 0x28 reserved for Moog 
<IdentityObject_ProductCode> - product number 
<IdentityObject_RevisionNumber> - revision number 
<IdentityObject_SerialNumber> - serial number 
Specification: CiA DS301 

Communication →→→→ 
CANopen 

Network management 

<NodeID> 

<DeviceType> 

<IdentityObject> 
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8.2.1.2 NMT state machine 
Status changes in the NMT State Machine when the operator clicks on one 
of the buttons {Operational, Prepared, Pre-Operational, Reset Application, 
Reset Communication}.  
Specification: CiA DS301 

Operational 
Sends the command start_remote_node – Change to the status Operational 
(transmission of PDO's is enabled).  

Prepared 
Sends the command stop_remote_node – Change to the status Prepared. 
(transmission of SDO's and PDO's is disabled).  

Pre-Operational 
Sends the command enter_pre_operational_state – Change to the status 
Pre-Operational. (transmission of PDO's is disabled).  

Reset Application 
Sends the command reset_node – Change to the status Pre-Operational, 
whereby the states Reset Application and Reset Communication will be exe-
cuted.  

Reset Communication 
Sends the command reset_communication – Change to the status Pre-
Operational, whereby the status Reset Communication will be executed.  

8.2.1.3 COB ID 
 The CAN identifiers for the following CANopen protocols are located in this 
area.  

ServerSdoParameter_CobIdClientServer / 
ServerSdoParameter_CobIdServerClient 
The CAN identifiers that the device is using for the SDO protocol handling.  
Specification: CiA DS301 

CobIdSyncMessage 
The CAN identifier that the device is using to receive the synchronization 
message (SYNC).  
Specification: CiA DS301 

CobIdEmergencyMessage 
The CAN identifier that the device is using to send error messages (EMCY).  
Specification: CiA DS301 

8.2.1.4 Node/Life Guarding 
The Node/Life Guarding protocol serves to monitor the device and the mas-
ter PLC.  

NMT state machine

{Operational}

{Prepared} 

{Pre-Operational}

{Reset Application}

{Reset Communication}

COB ID 

<CobIdClientServer> /
<CobIdServerClient> 

<CobIdSyncMessage>

<CobIdEmergencyMes-
sage> 
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GuardTime 
This parameter establishes the protocol's cycle time with which the device 
shall be monitored. 
Specification: CiA DS301 

LifeTimeFactor 
This parameter establishes the number of incomplete node guarding cycles, 
after that a fault reaction (Life-Guarding Event) will be triggered.  
Specification: CiA DS301 

FaultReaction_NodeGuardFaultReaction 
This parameter is used to configure the fault reaction to a Life Guarding 
Event.  
Specification: manufacturer-defined 

8.2.2 Receive PDO`s 
The four PDO channels for receiving process data can be configured in the 
tab Communication → CANopen → Receive PDO’s.  
 

 
Fig. 38: Tab Receive PDO’s 

8.2.2.1 ReceivePdoCommunicationParame-
ter_NthReceivePdo_CobIdUsedByPdo 

The CAN identifier that the device is using to receive the incoming process 
data message (RPDO).  
Specification: CiA DS301 

<GuardTime> 

<LifeTimeFactor> 

<NodeGuardFaultReac-
tion> 

<CobIdUsedByPdo> 
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8.2.2.2 ReceivePdoCommunicationParame-
ter_NthReceivePdo_TransmissionType 

The RPDO's transmission type.  
Specification: CiA DS301 

8.2.2.3 ReceivePdoCommunicationParame-
ter_NthReceivePdo_EventTimer 

Expiry time of the process data 
Specification: CiA DS301 

8.2.2.4 ReceivePdoMappingParameter_NthReceivePdoMapping_
 NumberOfMappedApplicationObjectsInPdo 

Number of mapping parameters within the RPDO.  

 
Set this value to NULL before determining the mapping parame-
ters for the RPDO. After completion of the parameter mapping, 
the desired number can finally be configured.  

 
Specification: CiA DS301 

8.2.2.5 ReceivePdoMappingParameter_nthReceivePdoMapping
 PdoMappingForTheNthApplicationObjectToBeMapped 

Mapping parameters 1 through 8 for the RPDO.  
Specification: CiA DS301 

8.2.3 Transmit PDO`s 
The four PDO channels for transmitting process data can be configured in 
the tab Communication → CANopen → Transmit PDO’s.  
All parameters and functions that appear in this tab are defined in the 
CANopen standard and are known under the names listed below. Refer to 
the CANopen standard (CANopen DS 301, version 4.0 for more detailed in-
formation.  

 
Fig. 39: Tab Transmit PDO’s 

<TransmissionType>

<EventTimer>

<NumberOfMappedAp-
plicationObjectsIn-
PDO> 

<PDOMapping
ForTheNthApplication 
ObjectToBeMapped> 
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8.2.3.1 TransmitPdoCommunicationParame-
ter_NthTransmitPdo_CobIdUsedByPdo 

The CAN identifier that the device is using to send the outgoing process data 
message (TPDO).  
Specification: CiA DS301 

8.2.3.2 TransmitPdoCommunicationParame-
ter_NthTransmitPdo_TransmissionType 

The TPDO's transmission type.  
Specification: CiA DS301 

8.2.3.3 TransmitPdoCommunicationParame-
ter_NthTransmitPdo_EventTimer 

Cycle time of the process data 
Specification: CiA DS301 

8.2.3.4 TransmitPdoMappingParameter_NthTransmitPdoMapping_
 NumberOfMappedApplicationObjectsInPdo 

Number of mapping parameters within the TPDO.  

 
Set this value to NULL before determining the mapping parame-
ters for the TPDO. After completion of the parameter mapping, 
the desired number can finally be configured.  

Specification: CiA DS301 

8.2.3.5 TransmitPdoMappingParameter_NthTransmitPdoMapping_
 PdoMappingForTheNthApplicationObjectToBeMapped 

Mapping parameters 1 through 8 for the TPDO.  
Specification: CiA DS301 

8.3 Application 

8.3.1 Demand-value generator 
The following functions and parameters are available for calculating the de-
mand values of the spool position and pressure controller closed loop.  
Unless otherwise specified, all parameters and functions that appear in the 
following tabs are defined in the device profile and are known under the 
names listed below. Refer to the device profile Fluid Power Technology 
(CANopen DS 408, Version 1.5) for more detailed information.  

8.3.1.1 Limitation 
The limitation function is used to limit the set point.  

 
This function exists both for the spool position demand value 
generator (ValvePositionControl_DemandValueGenerator) and 
for the pressure demand-value generator (ValvePressureCon-
trol_DemandValueGenerator).  

<CobIdUsedByPdo> 

<TransmissionType> 

<EventTimer> 

<NumberOfMappedAp-
plicationObjectsIn-
PDO> 

<PDOMappingForTheN-
thApplicationOb-
jectToBeMapped> 
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Fig. 40: Limit tab 

…_DemandValueGenerator_Limit_UpperLimit 
The upper limit value for the set point of the spool position or the pressure.  
Specification: CiA DS408 

…_DemandValueGenerator_Limit_LowerLimit 
The lower limit value for the set point of the spool position or the pressure.  
Specification: CiA DS408 

8.3.1.2 Scaling function 
The scaling function is used to scale the set point. The scaling is made ac-
cording to the function: 
Output = Input x <Factor> + <Offset> 

 
This function exists both for the spool position demand value 
generator (ValvePositionControl_DemandValueGenerator) and 
for the pressure demand-value generator (ValvePressureCon-
trol_DemandValueGenerator).  

<UpperLimit>

<LowerLimit>
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Fig. 41: Scale tab 

…_DemandValueGenerator_Scaling_Factor 
The factor by which the input is multiplied. This parameter contains a nu-
merator and a denominator from which the factor is formed. The quotient 
can be entered directly into the left field; enter the numerator in the upper 
field and the denominator in the lower field.  
Specification: CiA DS408 

…_DemandValueGenerator_Scaling_Offset 
The offset that is added to the multiplied input.  
Specification: CiA DS408 

8.3.1.3 Ramping function 
The ramping function is used to limit the signal's slew rate to a predefined 
ramping time.  

 
This function exists both for the spool position demand value 
generator (ValvePositionControl_DemandValueGenerator) and 
for the pressure demand-value generator (ValvePressureCon-
trol_DemandValueGenerator).  

<Factor> 

<Offset> 
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Fig. 42: Ramp tab 

…_DemandValueGenerator_Ramp_Type 
The ramp type activates a one-quadrant, two-quadrant, or four-quadrant 
ramp. Select the desired function by choosing one of the radio buttons {Off}, 
{One Quadrant}, {Two Quadrant} or {Four Quadrant}.  
Specification: CiA DS408 

…_DemandValueGenerator_Ramp_…_Unit 
The ramping time unit is specified to be 'seconds'.  
Specification: CiA DS408 

…_DemandValueGenerator_Ramp_…_Prefix 
The ramping times can be specified in the gradations of 10-3, 10-2, 10-1, and 
100 (corresponds to {1 sec, 100ms, 10ms, 1ms}). The desired resolution of 
time can be selected by the corresponding fields.  
Specification: CiA DS408 

…_DemandValueGenerator_Ramp_AccelerationTime_Value 
One-quadrant ramp: ramping time during the acceleration phase or decel-
eration phase for positive or negative movement directions.  
Two-quadrant ramp: ramping time during the acceleration phase for positive 
or negative movement directions.  
Specification: CiA DS408 

…_DemandValueGenerator_Ramp_DecelerationTime_Value 
Ramping time in the deceleration phase for positive or negative movement 
directions, effective in the two-quadrant ramp.  
Specification: CiA DS408 

<Type> 

<Unit> 

<Prefix> 

<AccelerationTime>

<DecelerationTime>
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…_DemandValueGenerator_Ramp_AccelerationTimePositive_Value 
Ramping time in the acceleration phase for positive movement direction, ef-
fective in the four-quadrant ramp.  
Specification: CiA DS408 

…_DemandValueGenerator_Ramp_AccelerationTimeNegative_ 
Value 
Ramping time in the acceleration phase for negative movement direction, ef-
fective in the four-quadrant ramp.  
Specification: CiA DS408 

…_DemandValueGenerator_Ramp_DecelerationTimePositive_Value 
Ramping time in the deceleration phase for positive movement direction, ef-
fective in the four-quadrant ramp.  
Specification: CiA DS408 

…_DemandValueGenerator_Ramp_DecelerationTimeNegative_ 
Value 
Ramping time in the deceleration phase for negative movement direction, ef-
fective in the four-quadrant ramp.  
Specification: CiA DS408 
 

 
The ramping time corresponds to the time that the output signal 
needs for a change of 0 to 100%.  

 

8.3.1.4 Directional-dependent gain 
With the directional-dependent gain, the signal will be reduced by a factor 
depending on the direction of movement.  
 

 
This function exists only for the spool position demand value 
generator (ValvePositionControl_DemandValueGenerator).  

<AccelerationTime-
Positive> 

<AccelerationTimeNe-
gative> 

<DecelerationTime-
Positive> 

<DecelerationTimeNe-
gative> 
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Fig. 43: Direction tab 

…_DemandValueGenerator_DirectionalDependentGain_Type 
The type of directional-dependent gain function, either activated or deacti-
vated. One of the options {Off} or {Type 1} can be selected by either clicking 
or dragging the slider.  
Specification: CiA DS408 

…_DemandValueGenerator_DirectionalDependentGain_Factor 
The factor by which one side of the input will be multiplied or divided. The 
calculation is performed in dependence of the factor's ratio to the number 
one.  
This parameter contains a numerator and a denominator from which the fac-
tor is formed. The factor can be entered directly as a quotient into the left 
field; the numerator can be entered in the upper field and the denominator in 
the lower field.  
Specification: CiA DS408 

8.3.1.5 Characteristic 
With the characteristic function, the input can be manipulated with a desired 
characteristic.  

 
This function exists only for the spool position demand value 
generator (ValvePositionControl_DemandValueGenerator).  

 
 

<Type> 

<Factor> 
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Fig. 44: Characteristic tab 

…_DemandValueGenerator_CharacteristicCompensation_Type 
The characteristic function type is either manufacturer-defined or deacti-
vated. One of the options {Off} or {Look Up Table} can be selected by either 
clicking or dragging the slider.  
Specification: CiA DS408 

…_DemandValueGenerator_CharacteristicCompensation_ 
LookUpTable 
The characteristic by means of a look-up table. The look-up table can be 
loaded from a file by clicking onto the button 'Load From File'.  
Specification: manufacturer-defined 

8.3.1.6 Dead band compensation 
The dead band compensation can be used to configure the dead band char-
acteristic of the spool position.  

 
This function exists only for the spool position demand value 
generator (ValvePositionControl_DemandValueGenerator).  

 

<Type> 

<LookUpTable> 
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Fig. 45: Deadband tab 

…_DeadbandCompensation_Type 
The dead band compensation can be activated with this parameter. One of 
the options {Off}, {step} or {servo} can be selected by either clicking or drag-
ging the slider.  
Specification: CiA DS408 

…_DeadbandCompensation_ASide 
The jump height for the positive direction of movement.  
Specification: CiA DS408 

…_DeadbandCompensation_BSide 
The jump height for the negative direction of movement.  
Specification: CiA DS408 

…_DeadbandCompensation_Threshold 
Step dead band compensation: in this input-signal value range the output is 
defined as null.  
Servo dead band compensation: in this input-signal value range the output is 
interpolated between null and the respective jump height.  
Specification: CiA DS408 

8.3.1.7 Zero correction 
The zero correction function can be used to shift the demand value up or 
down by any desired amount.  

 
This function exists only for the spool position demand value 
generator (ValvePositionControl_DemandValueGenerator).  

<Type> 

<ASide> 

<BSide> 

<Threshold>
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Fig. 46: Zero correction function 

…_ ZeroCorrection_Offset 
This is the value that is added to the input.  
Specification: CiA DS408 

8.4 Controller 

8.4.1 Control monitoring 
The control monitoring recognizes malfunctions in the control of the spool 
position and the pressure.  

 
This function exists both for the spool position closed loop (Val-
vePositionControl) and for the pressure control closed loop (Val-
vePressureControl).  

 

<Offset> 
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Fig. 47: Monitoring tab 

…_ControlMonitoring_Type 
Function type of the control monitoring, either deactivated or standard con-
trol monitoring.  
One of the options {Off} or {Standard} can be selected by either clicking or 
dragging the slider.  
Specification: CiA DS408 

…_ControlMonitoring_UpperThreshold 
Upper limit value of the control deviation. When this limit value is exceeded 
and after expiry of the delay time, the error bit in the status word <De-
vice_StatusWord> will be set.  
Specification: CiA DS408 

…_ControlMonitoring_LowerThreshold 
Lower limit value of the control deviation. When this limit value is under-run 
and after expiry of the delay time, the error bit in the status word <De-
vice_StatusWord> will be set.  
Specification: CiA DS408 

…_ControlMonitoring_DelayTime 
Delay time in milliseconds.  
Specification: CiA DS408 

8.4.2 Spool position controller 
The control parameters of the spool position controller are available only in a 
higher access level.  

<Type> 

<UpperThreshold>

<LowerThreshold>

<DelayTime>



 

Controller 8 Description of the parameters

58 Manual MoVaCo, version 0.2; 04/03 © Moog GmbH

8.4.3 Pressure controller 

8.4.3.1 Pressure transducer calibration 
The characteristic of an integrated pressure transducer can be corrected  us-
ing the pressure transducer calibration function. Integrated pressure trans-
ducers are already calibrated at the factory. Therefore, in its original delivery 
condition the pressure transducer will have the value "zero" for atmospheric 
pressure and the value 16384 for the device's specified nominal pressure. 

 
Integrated pressure transducersare calibrated at the factory, so 
manual adjustments are initially not required. However, the ef-
fects of aging may make corrections necessary.  

 

 

Fig. 48: Transducer tab 

Valve_ActualValueConditioning_MaximumPressure 
Upper level of measured pressure, related to the parameter <Maximum-
TransducerSignal>. The value is provided in relation to the nominal pressure 
and is based on the internal resolution iR.  
Specification: CiA DS408 

Valve_ActualValueConditioning_MinimumPressure 
Lower level of measured pressure, related to the parameter <Minimum-
TransducerSignal>. The value is provided in relation to the nominal pressure 
and is based on the internal resolution iR.  
Specification: CiA DS408 

Valve_ActualValueConditioning_MaximumTransducerSignal 
Transducer signal at the upper measured pressure level. The signal is based 
to the internal resolution iR. 

<MaximumPressure> 

<MinimumPressure> 

<MaximumTransducer-
Signal> 
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In its original delivery condition, the resulting pressure signal at 
nominal pressure is 100%, which corresponds to the value 
16384 based on the internal resolution iR. 

Specification: CiA DS408 

Valve_ActualValueConditioning_MinimumTransducerSignal 
Transducer signal at the smallest measured pressure level. The signal is re-
lated to the internal resolution iR 
 

 

In its original delivery condition, the resulting pressure signal at 
atmospheric pressure is 0%, which corresponds to zero based 
on the internal resolution iR. 

 
Specification: CiA DS408 

Valve_ActualValueConditioning_PressureOffset 
Correctional value that is added to the transducer signal.  
Specification: CiA DS408 

8.4.3.2 Pressure control parameters 
The pressure controller output signal is fed to the subordinated controller 
(servo valve: spool position controller, radial piston pump: stroke ring 
controller) as a demand value. The controller structure corresponds to a 
PIDT1 controller; however, unlike a PIDT1 controller, the DT1 partition is 
derived not from the control deviation but from the actual pressure value. 
This modification of PIDT1 structure typically leads to a better damping 
behavior in hydraulic drives. 
The integrator works within a freely adjustable control window with the speci-
fied integrator gain. Outside of this control window, the integrator can be op-
erated with a deviating gain that is derived from a factor and the adjusted in-
tegrator gain. The integrator is equipped with an anti-wind-up mechanism 
that prevents the drifting of the integration value when the pressure level 
cannot be achieved.  
The demand value can be limited via a ramp to a defined rate in order to re-
duce over-shoots of the pressure in case of commanded pressure jumps.  
By means of a control parameter estimation, the proportional-, integrator-, 
and the differentiation gain as well as the maximum pressure demand rate 
can automatically be set by adjusting just one parameter. This parameter 
corresponds to the hydraulic capacity CH (liters/bar) of the volume to be con-
trolled and can be easily estimated or evaluated.  
Switching to a PIDT1 controller with additional gain compensation for altered 
working and system pressure can, in many cases, improve the control qual-
ity. 
 
Sixteen pressure controller parameter sets are available, selectable by just 
one parameter. Thereby a simple and fast change over to various controller 
settings in real-time is possible..  

<MinimumTransducer-
Signal> 

<PressureOffset>
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Fig. 49: Parameter tab 

ValvePressureControl_PressureControllerType 
The pressure controller type selects between a standard PIDT1 controller 
structure to a PIDT1 controller structure with additional gain compensation 
for altered working and system pressure.  
One of the options {PIDT1} or {Advanced}.can be selected by either clicking 
or dragging the slider.  

PIDT1 
The pressure controller works as a PIDT1 controller.  
Specification: manufacturer-defined 

Advanced 
The pressure controller works as a PIDT1 controller with gain compensation 
for altered working and system pressure.  
Specification: manufacturer-defined 

ValvePressureControl_SystemPressure 
The system pressure must be known in order for the pressure controller to 
function properly in the mode {Advanced}.  
Specification: manufacturer-defined 

ValvePressureControl_ReferencePressure 
The working pressure must be known in order for the pressure controller to 
function properly in the mode {Advanced}. The working pressure corre-
sponds to the mean pressure level for which the PIDT1 controller was opti-
mized.  
Specification: manufacturer-defined 

<PressureController-
Type> 

{PIDT1} 

{Advanced} 

<SystemPressure> 

<ReferencePressure> 



 

8 Description of the parameters Controller

61 Manual MoVaCo, version 0.2; 04/03 © Moog GmbH

ValvePressureControl_HydraulicCapacity 
The hydraulic capacity CH (liters/bar) of the volume to be controlled serves to 
automatically set the proportional-, integration-, and differentiation gain or 
time constant, respectively, as well as the pressure demand rate.  

ValvePressureControl_RampSlope 
The maximum pressure rate of the commanded pressure demand is limited 
by means of a ramp. The value of this parameter corresponds to the ramp 
time in milliseconds. 

 
The ramping time corresponds to the time that the output signal 
needs for a change of 0 to 100%.  

 
 

ValvePressureControl_ProportionalGain 
The proportional gain of the pressure controller.  
Specification: manufacturer-defined 

ValvePressureControl_ProportionalPart 
The proportional part of the pressure controller's proportional controller unit. 
This parameter can be used to observe the behavior of the proportional part.  
Specification: manufacturer-defined 

ValvePressureControl_IntegratorControlRange 
The control range of the pressure controller's integrator. If the pressure  con-
trol deviation is within this range, then the integrator is working with the ad-
justed integrator gain <ValvePressureControl_IntegratorGain>; if the pres-
sure control deviation is out of this range, then there is a gain effective that is 
calculated from the factor <ValvePressureControl_IntegratorFactor> and 
the adjusted integrator gain.  
Specification: manufacturer-defined 

ValvePressureControl_IntegratorGain 
The pressure controller's integrator gain in 1/millisecond.  
Specification: manufacturer-defined 

ValvePressureControl_IntegratorFactor 
The pressure controller's integrator gain factor weights the integrator gain 
<ValvePressureControl_IntegratorGain> in case the pressure control devia-
tion is out of the adjusted integrator control range <ValvePressureCon-
trol_IntegratorControlRange>.  
Specification: manufacturer-defined 

ValvePressureControl_IntegratorUpperLimit 
The upper limit of the integrator part, that the pressure controller is allowed  
to reach.  
 

Specification: manufacturer-defined 

<HydraulicCapacity>

<RampSlope>

<ProportionalGain>

<ProportionalPart>

<IntegratorControl-
Range> 

<IntegratorGain>

<IntegratorFactor>

<IntegratorUpperLimit>



 

Diagnosis 8 Description of the parameters

62 Manual MoVaCo, version 0.2; 04/03 © Moog GmbH

ValvePressureControl_IntegratorLowerLimit 
The lower limit of the integrator part, that the pressure controller is allowed to 
reach.  
Specification: manufacturer-defined 

ValvePressureControl_IntegratorPart 
The integral proportion of the pressure controller's integrator. This parameter 
can be used to observe the behavior of the integrator.  
Specification: manufacturer-defined 

ValvePressureControl_DifferentiatorGain 
The pressure controller's differentiator gain.  
Specification: manufacturer-defined 

ValvePressureControl_DifferentiatorT1 
The time constant of the pressure controller's differentiator in milliseconds.  
Specification: manufacturer-defined 
The differentiation part of the pressure controller differentiator. This parame-
ter can be used to observe the behavior of the differentiator.  
Specification: manufacturer-defined 
 

8.5 Diagnosis 
In the Diagnosis tab error-diagnostics parameters as well as parameters for 
configuring the fault reaction during certain types of faults can be found.  

 

Fig. 50: Diagnosis tab 

<IntegratorLowerLimit> 

<IntegratorPart> 

<DifferentiatorGain> 

<DifferentiatorT1> 

<DifferentiatorPart> 
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8.5.1 Error detection 

8.5.1.1 Pre-defined Error Field 
The errors are stored in a list with 16 entries. The error codes are defined in 
the DS408 device profile.  

PreDefinedErrorField_NumberOfErrors 
The number of saved errors in the Pre-defined Error Field.  
Specification: DS301 

PreDefinedErrorField_StandardErrorField 
A list with 16 entries in which the error code for describing the cause of the 
error as well as manufacturer-defined information is stored. The most re-
cently entered error is always in the first position of the list, thereby produc-
ing a chronological order.  
Specification: DS301 

PreDefinedErrorField_ErrorRegister 
An error register that permits classification of the most recently appearing er-
ror by means of bit coding.  
Specification: DS301 

8.5.2 Handling faults 

8.5.2.1 Fault reaction 
The fault reactions {no fault reaction}, {Emergency Message}, {Fault Hold}, 
and {Fault Disabled} are available for selection.  

No fault reaction 
The fault is ignored and no fault reaction occurs.  

Emergency Message 
Send an emergency message, no other fault reaction.  

Fault Hold 
Send an emergency message, switch to the device status FAULT HOLD 
(see chapter 8.1.5).  

Fault Disabled 
Send an emergency message, switch to the status FAULT DISABLED (see 
chapter 8.1.5).  

8.5.2.2 Fault types 

FaultReaction_DspErrorFaultReaction 
Fault reaction when a fault appears in the digital signal processing.  
Specification: manufacturer-defined 

<NumberOfErrors>

<StandardErrorField>

<ErrorRegister>

{No fault reaction}

{Emergency Message}

{Fault Hold}

{Fault Disabled}

<DspErrorFaultReac-
tion> 
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FaultReaction_CpuSupplyFaultReaction 
Fault reaction when the CPU's supply voltage is lower or greater than 
permitted.  
Specification: manufacturer-defined 

FaultReaction_PowerSupplyFaultReaction 
Fault reaction when the device's supply voltage is lower or higher than per-
mitted.  
Specification: manufacturer-defined 

FaultReaction_TemperatureFaultReaction 
Fault reaction when the ambient temperature is lower or higher than permit-
ted.  
Specification: manufacturer-defined 

FaultReaction_LvdtErrorFaultReaction 
Fault reaction when there is a fault in the spool position transducer.  
Specification: manufacturer-defined 

FaultReaction_HardwareErrorFaultReaction 
Fault reaction when there is a general fault in the electronics hardware.  
Specification: manufacturer-defined 

FaultReaction_ControlErrorFaultReaction 
Fault reaction when there is a controller fault in the spool controller or pres-
sure controller.  
Specification: manufacturer-defined 

FaultReaction_CurrentControlErrorFaultReaction 
Fault reaction when there is a controller fault in the current regulator.  
Specification: manufacturer-defined 

<CpuSupplyFaultReac-
tion> 

<PowerSupplyFaultRe-
action> 

<TemperatureFaultRe-
action> 

<LvdtErrorFaultReac-
tion> 

<HardwareErrorFaul-
tReaction> 

<ControlErrorFaultRe-
action> 

<CurrentControlError-
FaultReaction> 
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8.6 Saving and restoring 
Parameters are saved and restored in accordance with the procedure de-
scribed in the CANopen Standard DS301.  

 

Fig. 51: Save/restore function 

 

8.6.1 Saving parameters 
Via the buttons {all}, {application}, {communication}, {manufacturer defined} 
on the left side of the tab, the parameters will be non-volatile saved in the 
device .  

8.6.1.1 All 
Saves all parameters in the device's non-volatile memory. After acknowl-
edge of the dialog that opens, a signature will be written to the parameter 
<SaveAllParameters>  so that the data will be saved in the device.  

StoreParameters_SaveAllParameters 
Saves all parameters in the non-volatile memory.  
Specification: DS301 

8.6.1.2 Application 
Saves all application parameters in the device's non-volatile memory. After 
acknowledge of the dialog that opens, a signature will be written to the pa-
rameter <SaveApplicationParameters>  so that the data will be saved in the 
device.  

StoreParameters_SaveApplicationParameters 
Saves all application parameters in the non-volatile memory. Application pa-
rameters include all parameters that are defined in the DS408 device profile.  

{All} 

<SaveAllParameters>

{Application}

<SaveApplication-
Parameters> 
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Specification: DS301 

8.6.1.3 Communication 
Saves all communication parameters in the device's non-volatile memory. 
After acknowledge of the dialog that opens, a signature will be written to the 
parameter <SaveCommunicationParameters>  so that the data will be saved 
in the device.  

StoreParameters_SaveCommunicationParameters 
Saves all communication parameters in the non-volatile memory. Communi-
cation parameters include all parameters that are defined in the CANopen 
Standard DS301.  
Specification: DS301 

8.6.1.4 Manufacturer defined 
Saves all manufacturer-defined parameters in the device's non-volatile 
memory. After acknowledge of the dialog that opens, a signature will be writ-
ten to the parameter <SaveManufacturerDefinedParameters>  so that the 
data will be saved in the device.  

StoreParameters_SaveManufacturerDefinedParameters 
Saves all manufacturer-defined parameters in the non-volatile memory.  
Specification: DS301 

8.6.2 Restoring parameters 
Via one of the buttons {all}, {application}, {communication}, {manufacturer 
defined} on the right side of the tab, the factory parameter settings can be 
restored. Depending on the parameter group, it will then be necessary to re-
set the device by means of the reset communication or reset application ser-
vices (see chapter 8.2.1.2) in order to finalize restoration of the parameters.  

8.6.2.1 All 
Restores the factory settings for all parameters in the device. After acknowl-
edge of the dialog that opens, a signature will be written to the parameter 
<RestoreAllDefaultParameters> so that the device is prepared for restora-
tion.  

StoreParameters_RestoreAllDefaultParameters 
Restores the factory settings for all parameters.  
Specification: DS301 

 
In order to restore the factory settings, after this parameter was 
written, a reset of the device needs to be performed by means of 
the NMT service reset application.  

8.6.2.2 Application 
Restores the factory settings for application parameters in the device. After 
acknowledge of the dialog that opens, a signature will be written to the pa-
rameter <RestoreApplicationDefaultParameters> so that the device is pre-
pared for restoration.  

{Communication} 

<SaveCommunication-
Parameters> 

{Manufacturer defined} 

<SaveManufacturerDe-
finedParameters> 

{All} 

<RestoreAllDefault-
Parameters> 

{Application} 
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StoreParameters_RestoreApplicationDefaultParameters 
Restores the factory settings for application parameters. Application parame-
ters include all parameters that are defined in the DS408 device profile.  
Specification: DS301 

 
In order to restore the factory settings, after this parameter was 
written, a reset of the device needs to be performed by means of 
the NMT service reset application.  

8.6.2.3 Communication 
Restores the factory settings for communication parameters in the device. 
After acknowledge of the dialog that opens, a signature will be written to the 
parameter <RestoreCommunicationDefaultParameters> so that the device is 
prepared for restoration.  

StoreParameters_RestoreCommunicationDefaultParameters 
Restores the factory settings for communication parameters. Communication 
parameters include all parameters that are defined in the CANopen Stan-
dard DS301.  
Specification: DS301 

 
In order to restore the factory settings, after this parameter was 
written, a reset of the device needs to be performed by means of 
the NMT service reset application or reset communication .  

8.6.2.4 Manufacturer defined 
Restores the factory settings for manufacturer-defined parameters in the de-
vice. After acknowledge of the dialog that opens, a signature will be written 
to the parameter <RestoreManufacturerDefinedDefaultParameters> so that 
the device is prepared for restoration.  

StoreParameters_RestoreManufacturerDefinedDefaultParameters 
Restores the factory settings for manufacturer-defined parameters.  
Specification: DS301 

 
In order to restore the factory settings, after this parameter was 
written, a reset of the device needs to be performed by means of 
the NMT service reset application.  

8.7 Device information 
 

<RestoreApplication-
DefaultParameters> 

{Communication}

<RestoreCommunica-
tionDefaultParameters> 

{Manufacturer defined}

<RestoreManufactur-
erDefinedDefault-
Parameters> 
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Fig. 52: Information tab 
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8.7.1 Device profile, informational parameters 

8.7.1.1 Device_CodeNo 
An individual code that will identify the device in the machinery can be en-
tered here.  
Specification: DS408 

8.7.1.2 Device_ParameterSetCode 
An individual parameterization code can be entered here. As soon as the 
factory settings are restored, this code will be reset to null.  
Specification: DS408 

8.7.1.3 Device_DeviceVersion 
Specifies the device version.  
Specification: DS408 

8.7.1.4 Device_SerialNo 
The device's serial number.  
Specification: DS408 

8.7.1.5 Device_Description 
An individual descriptive text that will identify the device in the machinery 
can be entered here.  
Specification: DS408 

8.7.1.6 Device_ModelDescription 
The device's model description.  
Specification: DS408 

8.7.1.7 Device_ModelURL 
An Internet address under which additional information is available about the 
device.  
Specification: DS408 

8.7.1.8 Device_VendorName 
The manufacturer's name.  
Specification: DS408 

8.7.1.9 Device_Capability 
Description of functions that support the device.  
Specification: DS408 

<CodeNo> 

<ParameterSetCode>

<DeviceVersion>

<SerialNo> 

<Description>

<ModelDescription>

<ModelURL>

<VendorName>

<Capability>
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8.7.2 CANopen information parameter 

8.7.2.1 Device_ManufacturerDeviceName 
The device's manufacturer name.  
Specification: DS301 

8.7.2.2 Device_ManufacturerHardwareVersion 
The device's hardware version.  
Specification: DS301 

8.7.2.3 Device_ManufacturerSoftwareVersion 
The device's software version.  
Specification: DS301 
 

For your notes 
 

<ManufacturerDevice-
Name> 

<ManufacturerHard-
wareVersion> 

<ManufacturerSoft-
wareVersion> 
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9 What to do in case of problems? 

9.1 CAN interface card 
Outdated or incompatible driver versions can lead to problems when operat-
ing the program with a CAN interface card. The actual driver version can be 
viewed in the bus configuration view.  
Solution: Uninstall the outdated or incompatible driver and then install the 
driver version recommended for the CAN interface card.  
The CAN interface card was not yet initialized.  
Solution: Perform an initialization, assuming that a CAN interface card is in-
stalled in the PC which the program supports. 

9.2 CAN bus cabling 
If the CAN bus cabling is not installed properly, the CAN communication may 
be severely disturbed or it may not be possible to send or receive any mes-
sages at all (communication error).  
Solution: Check the cabling (the plug's pin assignment) and make sure the 
CAN bus termination is correct. Compare the interface number of the CAN 
port attached to the CAN bus to the interface number set in the program.  

9.3 Device's CAN bit rate is not known 
CAN communication will not be possible if the device's bit rate is unknown.  
Solution: First connect the device directly to the PC's CAN interface card 
(there may be no other bus nodes attached to the CAN bus). Set the lowest 
bit rate and switch to the online mode. Then disconnect the device's voltage 
supply for a few seconds and then reconnect it. Look in the warnings display 
to see if a boot-up message appears. If no message appears, repeat this 
process with the next-highest bit rate until the boot-up message could be re-
ceived.  
Attention: all bus nodes must be set to the same bit rate.  

9.4 The device's node ID is not known 
If the node ID set for the device is not known, it will not be possible to estab-
lish a connection to the attached bus nodes.  
Solution: Switch to the online mode in the program's bus configuration view. 
Then disconnect the device's voltage supply for a few seconds and then re-
connect it. A boot-up message from the device (with indication of the node 
ID) will appear in the warnings display.  

Outdated or incompati-
ble driver version 

CAN interface card not 
initialized 

No CAN communica-
tion or faulty communi-
cation 

No CAN communica-
tion 

Connection not estab-
lished 
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